APA Formatting (6th ed.)

Eastern Florida State College
Writing Center
Before You Begin

The American Psychological Association (APA) system of documentation is the style most often used for psychology and other social science courses.

Some slight format variations exist, so please check with your instructor for any clarification.


Common APA Sections
- Title Page
- Abstract
- Main Body
- References
Basic APA Format

2. Double space all text lines, including figure captions
3. Remove space after the paragraph
4. Left justify
5. 1-inch margins
Creating the Header

1. Click the upper inch of the document twice; edit the header ➔ Select Different First Page
2. In top left corner, type Running head; and then IN ALL CAPS a shortened version of your paper’s title
3. Tab until your cursor is on the far right corner.
4. Use Times New Roman, size 12 font for header and page number
5. Page Number ➔ Current Position ➔ Plain 1 ➔ Close Header and Footer
Title Page

1. Press Return/Enter 5 times until text is in the upper third of the page.

2. Align text to Center

3. Select Times New Roman, size 12 font

4. Type your paper’s full title, capitalizing essential words

5. On a new line, type your name

6. On a new line, type the school’s name, if there are multiple campuses, specify which campus.

7. Insert ➔ Pages ➔ Page Break for next page

REMEMBER: Always check instructor’s guidelines first for Title Page information!
Resetting the Header

APA requires two different headers: one for the Title Page and one for the rest of the paper. If you have not selected Different First Page under the Header Editing Tab, do so now.

1. On the next page, double click into the Header
2. Change your font to Times New Roman, size 12
3. On the left, type your shortened title in ALL CAPS. (Do not include Running head!)
4. Tab until the cursor is in the right corner
5. Page Number ➔ Current Position ➔ Plain 1
Abstracts are not always required for college papers. Please check your assignment instructions or ask your instructor first.

1. Type Abstract at the top of the page and align it to Center
2. Do NOT indent
3. Write 100-250 words summarizing your entire paper, including your introduction, body, and conclusion
4. Insert ➔ Pages ➔ Page Break for next page
There are three ways to set your indentations, either using the Paragraph Settings, using the Ruler, or using the Tab key.

Tab Key:
At the start of each paragraph, press Tab on your keyboard once.
**Indentations: Step-by-Step Instructions**

**Paragraph Settings**
1. Set your cursor on the line directly beneath the Title, justified to the left.
2. On the Home Tab, locate the Paragraph Box and then click the small icon in the very most bottom, right corner.
3. After the Paragraph Settings Box appears, find the **Indentation** Section. Then click the drop down labeled **Special**. Then click **First Line**.
4. Beside **Special**, in the box labeled **By**, set the indent to **0.5”**.
5. Click **OK** to set the Indent.

**Ruler**
1. Set your cursor on the line directly beneath the Title, justified to the left.
2. On the View tab, locate the Show Box and check the box beside Ruler.
3. Now a Ruler has appeared along the top and left side of the document.
4. On the top ruler, click the upper triangle of the hourglass-like icon between the grey and white
5. Drag the upper Triangle to right until it rests on the 4th measurement marker.
1. Full title at the top of the first page of the body, centered
   The title of your paper should not be italicized, bolded, or underlined!

1. Each paragraph indented 0.5-inches

2. Double space the entire paper, references included

3. No space between paragraphs (see below)

How to Avoid Spacing After Paragraph:
Open Paragraph Settings (see “Basic APA Formatting” slide) ➔ Spacing ➔ “After” should be 0
In-Text Citations

- Each of your in-text citations will correspond to its matching entry in your References section.

  Example:

  - In-text:
    Yanovski and Yanovski (2002) reported...

  - Reference:

- All outside information that you bring to your paper needs to have a citation. Depending on how the information appears in your paper, the way you format your in-text citations will change.
In-Text Citations: Basic Format

**Basic Format for Quotation**
Introduce the quote with a signal phrase that includes the author’s last name followed by the year of publication in parentheses. Place the page number (preceded by “p.”) in parentheses after the quotation.

*Example:*
Crister (2003) noted that despite growing numbers of overweight Americans, many health care providers still “remain either in ignorance or outright denial about the health danger to the poor and the young” (p.5).

**Basic Format for Summary/Paraphrase**
Include the author’s last name and the year either in the signal phrase or in the parentheses following it.

- A page number is not required for a summary/paraphrase, but include it if it will help readers find the passage. Options: page numbers, paragraph numbers and section titles

*Example:*
Yanovski and Yanovski (2002) explain that sibutramine suppresses appetite by blocking the reuptake of the neurotransmitters serotonin and norepinephrine in the brain (p. 594).
In-Text Citations: Basic Format (continued)

- If the author is not named in the signal phrase, place the author’s name, the year, and the page number in the parentheses after the quotation, ex: (Crister, 2003, p.5).

- APA style requires a year of publication in in-text citations. Do not include a month, even if available.

Examples:

- Yanovski and Yanovski (2002), explain that sibutramine suppresses appetite by blocking the reuptake of the neurotransmitters serotonin and norepinephrine in the brain (p. 594).

- Sibutramine suppresses appetite by blocking the reuptake of the neurotransmitters serotonin and norepinephrine in the brain (Yanovski & Yanovski, 2002, p. 594).
In-Text Citation Examples

Quote with Author Introduction

The publication year follows the author’s last name. Only the page number follows the quotation in the parenthetical citation.

Quote without Author Introduction

When not using a signal phrase, the parenthetical citation includes the author’s last name, year published, and the page number.
In-Text Citations: Authors

- If the author is not named in the signal phrase, place the author’s name, the year, and the page number in the parentheses after the quotation. Example: (Crister, 2003, p.5)

- APA style requires a year of publication in in-text citations. Do not include a month, even if available.

- Depending on how many authors a source has, your citation will include either an “&” symbol or an “et al.” to indicate that you have multiple authors.
In-Text Citations: Multiple Authors

Works with Two Authors
Give the names of both authors in the signal phrase or the parentheses each time you cite the work. In the parentheses, use “&” between authors’ names; in signal phrases, use “and.”

Example:
According to Sothern and Gordon (2003), “Environmental factors may contribute as much as 80% to the causes of childhood obesity” (p.104).

-OR-
Obese children often engage in limited physical activity (Sothron & Gordon, 2003, p.104).

Works with Three to Five Authors
Identify all authors in the signal phrase or the parentheses the first time you cite the source.

Example:
In 2003, Berkowitz, Wadden, Tershakovec, and Cronquist concluded, “Sibutramine...must be carefully monitored in adolescents, as in adults” (p.1811).

In subsequent citations, use the author’s first name followed by “et al.” in either the signal phrase or parentheses.

As Berkowitz et al. (2003) advised, “weight loss medications should only be used experimentally in adolescents” (p. 1811).

Works with Six or More Authors
Use the author’s first name followed by “et al.” in the signal phrase or parentheses.

Example:
McDuffie et al. (2002) tested 20 adolescents, aged 12-16, over a three month period and found that orlistat, combined with behavioral therapy produced an average weight loss of 4.4 kg, or 9.7 pounds (p.646).
In-Text Citations: Unique Situations

Work with Unknown Author

Mention the work’s title in the signal phrase or give the first word or two of the title in the parentheses. Article titles & book chapter titles go in quotations; book titles and report titles are italicized.

Example:
Children struggling to control their weight must also struggle with the pressures of television advertising that, on the one hand, encourages the consumption of junk food and, on the other, celebrates thin celebrities (“Television,” 2002).

Organization as Author

Name the organization in the signal phrase or in the parenthetical citation the first time you cite the source.

Example:
Obesity puts children at risk for a number of medical complications, including Type 2 diabetes, hypertension, sleep apnea, and orthopedic problems (Henry J. Kaiser Family Foundation, 2004, p. 1).

If the organization has an abbreviation:
First Citation: (Centers for Disease Control and Prevention [CDC], 2009)

Later Citations: (CDC, 2009)

Indirect Source

If you use a source cited in another source, name the original source in your signal phrase. List the secondary source in your reference list and include it in your parentheses, preceded by “as cited in.”

Example:
Former surgeon general Dr. David Satcher described “a nation of young people seriously at risk of starting out obese and doomining themselves to the difficult task of overcoming a tough illness” (as cited in Crister, 2003, p.4).
In-Text Citation: Long Quotes

- Long quotes should be used if they are needed.
- A long quote is any quote that is **40 words or more** in length.
- Introduce your quote with the author and publication year information as well as some context (see example).
- In APA, long quotes are entirely indented 0.5-inches on the left and remain Double Spaced.
- Unlike in shorter quotes, the period comes **before** the parenthetical citation (see example).

A report by the Animal Protection Agency (2001) informed potential pet owners of the importance of knowing their breed’s personality when it comes to choosing specific training techniques. It also stressed that pet owners must be patient and accept that training any pet takes time:

> Many animals will respond to the style of technique their owner chooses if it is presented consistently, patiently, and with love. However, certain breeds are more stubborn and resistant to training. If the style does not appear to be working, punishment is still not an option; animals do not understand punishment, and certain breeds may even react to punishment by harming their owner. (p.1)
Hanging Indents are only used in your References page (see example on Reference Page slide).

Instead of indenting the first line with the rest of the paragraph Left justified, the Hanging Indents keep the first line Left justified and the lines after it, indented by 0.5”.

Paragraph Settings
1. Open the Paragraph Settings box.
2. Everything remains the same except for under the dropdown labeled Special, change it from First Line to Hanging.

Ruler
1. At the top of the document, move the upper triangle back to its original placement.
2. Click and drag the hourglass to the 4th measurement marker.
3. Move the upper triangle only back to its original place.
Reference Page

- Start on a new page that includes your SHORT TITLE and page number.
- Center the title: References
- Left justify the entries.
- Alphabetize the entries.
- Remember to use a hanging indent for every line after the first of each entry (see previous “Hanging Indent” slide).
- Double space the entire page.

```
```
The DOI System

• The DOI (digital object identifier) is a unique and permanent identifier assigned to electronic sources like scholarly journal articles and e-books.

• In APA, you must include a DOI number (if available) in your references with all of your electronically accessed sources.

• The DOI is usually located on the first page of the electronic journal article, near the copyright notice or on the database page for the article.

• DOI Format for References:
doi: 10.xxxx/xxxx-xxxx.xx.xxx

• If no DOI given, use homepage URL
Reference Page Entries

- Capitalize only the first word of titles and subtitles of books.  
  **Example:** Understanding business: An entrepreneur’s guide to navigating the business world

- Separate multiple authors’ names with commas or the & sign (see examples).

- Avoid using automatic citation resources like EasyBib or others like it. They may be outdated, incomplete, or incorrect. Always double check your citations with the Writer’s Reference Handbook, the Writing Center, or your professor’s guidelines.
References: One to Five Authors (Books in Print as Examples)

**Book with One Author**
Author’s Last Name, First Initials of First & Middle Name. (Year Published). Book title in italics, only first letter capitalized. City, State Abbreviation: Publisher Name.

*Example:*

**Book with Two Authors**
1st Author Last Name, 1st Author Initials., & 2nd Author Last Name, 2nd Author Initials. (Year Published). Title of book. City, State Abbreviation: Publisher Name.

*Example:*

**Book with Three to Five Authors**
Last Name, First Initial., 2nd Last Name, First Initial., & 3rd Last Name, First Initial. (Year Published). Title of book. City, State Abbreviation: Publisher Name.

*Example:*
Books with Five to Seven Authors

1st Author’s Last Name, First Initial., 2nd Author’s Last Name, First Initial, 3rd Author’s Last Name, First Initial, 4th Author’s Last Name, First Initial, & 5th Author’s Last Name, First Initial. (Year Published). Title of book. City, State Abbreviation: Publisher Name.

Example:

Books with Eight or More Authors

1st Author’s Last Name, First Initial., 2nd Author’s Last Name, First Initial., 3rd Author’s Last Name, First Initial., 4th Author’s Last Name, First Initial., & 5th Author’s Last Name, First Initial., 6th Author’s Last Name, First Initial., … Last Author’s Last Name, First Initial. (Year Published). Title of book. City, State Abbreviation: Publisher Name.

Example:
Edition Other than the First

Last Name, First Initial. (Year Published). Title of work (# ed.). City, State Abbreviation: Publisher Name.

Example:

Article or Chapter in Edited Book or Anthology

Author of Chapter Last Name, First Initial. (Year Published). Title of chapter. In Book Editor(s) First Initial and Last Name(s) (Eds.), Book or anthology title (pp. of chapters). City, State Abbreviation: Publisher Name.

Example:

Introduction, Preface, Foreword or Afterword

Book Author’s Last Name, First Initial. (Year Published). Introduction/ Preface/ Foreword/Afterword. In Editor First Initial and Last Name (Ed.), Book title (pp. #). City, State Abbreviation: Publisher Name.

Example:
References: Books in Print with Editors

**Book with an Editor, No Author**
Editor(s) Last Name(s), First Initial(s). (Eds.) (Year Published). *Title of book* (# of Edition). City, State Abbreviation: Publisher Name.

**Example:**

Note: Use the abbreviation “Ed.” for a single editor, or “Eds.” for multiple editors.

**Book with an Author and an Editor**
Author’s Last Name, First Initials. (Year Published). *Title of journal article*. Name of the Journal in Italics, Volume Number (Issue #), page numbers. Retrieved from URL

**Example:**

Note: Use the abbreviation “Ed.” for a single editor, or “Eds.” for multiple editors.
References: Textbooks

Entire Textbook

Author Last Name, First Initial. (Year Published). 
Textbook title (Edition #.). City, State Abbreviation: Publisher Name.

Example:

Note: No page numbers are needed in Reference section. Only include them in in-text citations.

Chapter of Textbook

Author Last Name, First Initial. (Year Published). 
Chapter #: Chapter title. In Textbook title (# ed., pp. ##-##). City, State Abbreviation: Publisher Name.

Example:
References: eBooks

**eBook with URL**

Author's Last Name, First Initial of First Name. (Year Published). eBook title. Retrieved from URL

**Example:**


**eBook with DOI**

Author's Last Name, First Initial of First Name. (Year Published). eBook title. doi: 10.xxxx/xxxxxxxxxx

**Example:**


**Chapter in an eBook**

Author's Last Name, First Initial of First Name. (Year Published). Chapter title. In eBook title (pp. ##-##). Retrieved from URL

**Example:**

References:

Peer Reviewed Online Journal Article

Scholarly Journal Article with DOI
Author’s Last Name, First Initial. (Year Published). Title of journal article. Name of Journal in Italics, Volume Number (Issue #), page numbers. doi: 10.xxxx/xxxxxxxxxx

Example:

Scholarly Journal Article without DOI
Author’s Last Name, First Initials. (Year Published). Title of journal article. Name of the Journal in Italics, Volume Number (Issue #), page numbers. Retrieved from URL

Example:

Note: If no DOI is available, include the article’s URL information at the end of the reference (see examples.)
References:
Online Newspaper or Magazine

Online Newspaper
Author’s Last Name, First Initial. (Year, Month Day published). Article title with first word capitalized: Subtitle with first word capitalized. *Newspaper Name in Italicics*. Retrieved from URL.

Example:

Notes:
• Give the year, month and day for daily newspapers.
• Use “p.” or “pp.” for page numbers.

Online Magazine
Author’s Last Name, First Initial. (Year, Month Day published). Article title with first word capitalized: Subtitle with first word capitalized. *Title of Magazine in Italicics*, page numbers. Retrieved from URL.

Example:

Note: Give the year and month for monthly magazines; add day for weekly.
References: Works from Websites

Section of a Web Document
Author’s Last Name, First Initials or Organization Name. (Year Published). Title of section. In Title of web document: Subtitle of web document. Retrieved from URL

Example:

Short Work from a Website
Author Last Name, First Initial (if available). (Date Published). Title of document [Format description]. Retrieved from URL

Example:

Note: Only use [Format Description] if you are citing something unusual, like a blog post or lecture notes. Otherwise, it is not necessary.
Things to Remember

- Times New Roman, 12 pt.
- Double-spaced throughout
- Left Justified, 1-inch margins
- 0.5-inch Indentation
- Short Title and Page Number in the Header of each page
- In-text citations for every source used.
- References on its own page
- Citations in alphabetical order with a 0.5-inch Hanging Indent

- For additional help, you can always visit your campus’s writing center!